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Introduction

The North American Bat Monitoring Program (NABat) is a multi-national, multiagency coordinated monitoring program 
designed to assess the status and trends of North American bats at local, state, and range-wide scales. NABat monitoring efforts 
focus on the 47 species of bats shared by Canada, the United States, and Mexico. NABat is composed of a network of partners 
including local, State, Federal, and provincial agencies, Tribes, non-governmental organizations, and volunteers collecting bat 
survey data and invested in bat conservation. Information from NABat can be used to inform land management and conservation 
decisionmaking.

The success of NABat is predicated on making reliable inferences about bat distributions and their relative abundance from 
data collected and processed using standardized techniques and protocols in a consistent manner over space and time. In 2015, 
“A Plan for the North American Bat Monitoring Program (NABat)” (Loeb and others, 2015) was developed, providing the foun-
dation and overall direction needed for the initial implementation of NABat. Loeb and others (2015) represented the first step 
towards the establishment of standardized protocols, with the understanding that guidance would be refined and more specific 
protocols would be made available over time.

NABat relies in part on acoustic monitoring using stationary and mobile transect survey methodologies. Currently, how-
ever, acoustic data are being managed and processed using a variety of methods. These inconsistencies may introduce sources 
of undocumented, systematic bias that could limit the utility of these combined data for evaluating bat distributions and trends 
at broader scales. We believe there is a need for more specific guidance on detector settings, protocols for deploying acoustic 
detectors, and a standardized workflow for analyzing acoustic data. Standardized protocols and workflow can help to establish 
a common currency from which to improve the interpretation of acoustic data by reducing variation and uncertainty in how bat 
echolocation calls are collected, processed, and identified to species.

In 2017, the U.S. Geological Survey (USGS) Fort Collins Science Center hosted a workshop of bat acoustic experts with 
the goal of developing a suggested workflow to help standardize the analysis of acoustic data for NABat (NABat Acoustic Data 
Analysis Workflow Workshop, 2017). The guide that follows is a product of that workshop. While accurate and efficient analysis 
of bat acoustic data requires a minimum level of expertise and training, the suggested workflow is intended to help make this 

1U.S. Geological Survey

2Wildlife Conservation Society Canada

3USDA Forest Service

4Bat Call Identification, Inc.

5U.S. Army Corps of Engineers

6Illinois Natural History Survey

7Colorado Natural Heritage Program

8Montana Natural Heritage Program

9New York State Department of Environmental Conservation
10National Park Service
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process more repeatable and feasible for a wider pool of potential NABat partners, including those with limited resources and 
experience. To this end, the workflow was developed with the intention of minimizing the amount of time and effort required for 
processing bat acoustic data for NABat while following a “conservative” approach that reduces subjectivity and minimizes the 
potential for species misidentification.

The following provides general recommendations and specific workflows for the process of identifying bat species from 
acoustic files recorded using both stationary point and mobile transect acoustic monitoring protocols for NABat (Loeb and oth-
ers, 2015). It focuses exclusively on post-processing of acoustic data. For recommendations on detector settings and detector 
deployment, download the “NABat Guide to Site Selection for Stationary Point Monitoring” and the “NABat Guide to Acoustic 
Detector Settings” available on the “Resources” page of the NABat website (https://nabatmonitoring.org/#/resources).

The described workflow includes data attribution (step 1), noise scrubbing (step 2), automated species identification (auto 
ID) (step 3), manual vetting (step 4), and submitting data to NABat (step 5, fig. 1). Some auto ID software automates the process 
and allows you to complete steps 1–3 at once. The workflow varies at step 2 and step 4 for stationary versus mobile transect 
monitoring because of the inherent differences between objectives (that is, species occupancy versus species relative abundance, 
respectively). For detailed workflows and tips for using specific software programs see chapters 1–5 and appendixes A and B of 
this report.

This document is NOT meant to serve in place of the user manual or official documentation provided by the software 
developers. It should only serve to help users follow NABat protocols while using the available software. It is strongly recom-
mended that users are familiar with the software user’s manual before using this document.

\\IGSKAHCMVSFS002\Jeff\den18_0041_ofr_reichert\report_figures\den18-0041_fig01.ai

Step 1. Attribute Data

Step 3. Auto ID

Step 5. Submit to NABat

Step 2. Noise Scrubbing:
Stationary Point Acoustic Data

Step 4. Manual Vetting:
Stationary Point Acoustic Data

Step 4. Manual Vetting:
Mobile Transect Acoustic Data

Step 2. Noise Scrubbing:
Mobile Transect Acoustic Data

Figure 1. A general workflow for processing recorded acoustic 
files for the North American Bat Monitoring Program (NABat). 
Note: Workflow guidance varies between stationary point and 
mobile transect survey data at steps 2 and 4, because objectives 
differ between survey methodologies (site occupancy from 
stationary point acoustic data versus relative abundance of 
species from mobile transect data).
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Step 1. Attribute Acoustic Files
Download cards or recorded acoustic files to a hard drive. Be sure to retain all status and log files associated with record-

ings (these are indispensable for trouble-shooting missing data and low data rates).

Naming Acoustic Files

Use Grid Cell GRTS ID, Site Name, and timestamp (using 24-hour clock notation) as a prefix for call file names (see 
table 1 for definitions). When put together, Grid Cell GRTS ID and Site Name provide a unique identifier for each detector 
deployment.

Examples

• 5867_NW_20160712_210932: This file was recorded in a NABat grid cell with GRTS ID 5867, at the NW site 
(or quadrant), on July 12, 2016 at 21 hours (or 9 pm) 9 minutes and 32 seconds.

• 5867_DT_20160712_214930: This file was recorded in a NABat grid cell with GRTS ID 5867, on a mobile driving  
transect (DT), on July 12, 2016 at 21 hours (or 9 pm) 49 minutes and 30 seconds.

To more easily compare surveys across grid cells and sites over time, maintain a consistent naming convention. For your 
reference, it can be helpful to develop an “authority file” of your naming conventions so (1) each code is unique and (2) additional 
description can be entered for each code to properly identify the site.

Depending on detector and software system used, this naming prefix can typically be pre-programmed prior to field 
recording, and (or) can be edited for entire batches of files during post-processing. For example, with recordings made with the 
Pettersson D500X ultrasound recording unit (Pettersson Elektronik AB, http://www.batsound.com/) Grid Cell GRTS ID and 
Site Name can be appended to timestamped files when files are scrubbed and attributed in SonoBat software v4.2.1 (Szewczak 
and Szewczak, 2017) using the D500x File Attributer utility or the DataWizard utility. Both utilities can be used on any wave-
form audio-file format (.wav) recordings, including situations where filenames cannot be altered within the detector or analysis 
software. For guidance on detector settings see the “NABat Guide to Acoustic Detector Settings,” available for download here: 
https://nabatmonitoring.org/#/resources.

Assigning Metadata to Acoustic Files

It is important that each recorded acoustic file also be attributed with metadata (that is, information about the recorded 
file). To meet the data management requirements for NABat, Grid Cell GRTS ID, Site Name, and Timestamp must also 
be included as metadata for each file (see table 1 for definitions). It is also strongly recommended that the information in 
table 1 be added as metadata to individual files to help contextualize recordings. This information summarizes the record-
ing situation and should also be entered in the associated downloadable NABat Project Database (available for download at 
https://nabatmonitoring.org/#/tools).

These metadata fields may be represented using the extensible Grand Unified Acoustic Notation Ontology (GUANO) 
metadata format as follows:

NABat|Grid Cell GRTS ID: 5867
NABat|Site Name: NW

Additional resources for attributing files with metadata will be downloadable at the NABat Project website 
(https://nabatmonitoring.org/#/resources). See chapters 1–5 of this report for more details on how to assign metadata using 
specific software.

http://www.batsound.com/
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Table 1. Required and recommended metadata fields for the North American Bat Monitoring Program (NABat) acoustic files. 
Metadata should be embedded in individual files. Fields with * should also be used for naming acoustic files.

[km, kilometer; WGS, World Geodetic System 1984]

Field
Required or 

recommended
Description/Instruction

*Timestamp Required Time and date when recording occurred. 
*Grid Cell GRTS ID Required GRTS ID number of the NABat grid cell where the survey was conducted. This is also the NABat 

sampling priority of the grid cell based on the GRTS master sample, for example, lower GRTS 
ID = higher NABat sampling priority.

*Site Name Required A user-defined name (6-character limit) of the specific location (or point) where a detector was 
deployed within a single grid cell. Being consistent with site names from year to year allows 
for easier sorting and interpretation of the data. For example, if four stationary detectors were 
deployed, each within a 5 km × 5 km quadrant in the same 10 km × 10 km grid cell, Site 
Names used to describe the four deployment locations could be ‘NW’, ‘NE’, ‘SW,’ and ‘SE.’ 
Alternatively, Site Names can be based on a nearby town name, habitat type, property name, 
and so forth. If a mobile acoustic transect survey was conducted within the same grid, an ad-
ditional unique Site Name, for example, ‘DT’ (mobile driving transect), would be applied. 

NABat Project Name Recommended Your NABat Project Name is defined by the user when creating an NABat Project at  
https://nabatmonitoring.org/#/tools

NABat Project ID Recommended NABat Project ID is a unique project identifier provided to user when creating an NABat Project 
at https://nabatmonitoring.org/#/tools

Site coordinates Recommended Latitude and longitude (WGS 84).

Land unit code Recommended A user-defined 4-letter abbreviation describing your study area, region, park, state, or land unit. For 
example, if the survey is conducted in a park or refuge, use park or refuge codes (for example, 
YELL for Yellowstone National Park). If the survey is not carried out in a park or refuge, the 
user creates a 4-letter abbreviation for Land Unit Code based on the region or larger surround-
ing area (for example, SOCA for South Carolina, 3LMA for Three Lakes Wildlife Management 
Area). Note that multiple sites (Site Names) can exist within the same land unit code. 

Contact information Recommended Name of person/entity that recorded the file.

Detector type Recommended Brand and model

Microphone type Recommended Brand and model

Microphone height Recommended Height (meters) of microphone above ground.

Weather proofing Recommended Indicate whether weather proofing was used on microphone (yes or no).
Distance to clutter Recommended Distance (meters) between microphone and nearest clutter (for example, vegetation, buildings, or 

other structure) 

Type of clutter Recommended Nearest clutter type (for example, vegetation, buildings, or other structure).

Habitat type Recommended Broad habitat type surrounding microphone. 
Unusual occurrences Recommended Indicate whether unusual occurrences took place during the recording session that may impact the 

interpretation of results for example, power to detector may have been low, time not adjusted 
for daylight savings time, recording was interrupted due to dead batteries, filled data card, 
microphone or cable damage, schedule programming error, late deployment, deployment varies 
due to non-standard microphone mounting, incorrect detector settings, and so forth.).

Activation start time Recommended Time when detector was activated to start recording. Note that this may be different than deploy-
ment start time.

Activation end time Recommended Time when detector was deactivated. Note that this may be different than deployment end time.
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Step 2. Noise Scrubbing
Acoustic sampling for bats results in the recording of both bat echolocation calls and extraneous noise (that is, non-bat 

files). In some circumstances, files with extraneous noise can represent a large proportion of the recorded files. The goal of noise 
scrubbing is to identify and separate files with only extraneous noise from files with bat echolocation calls. Noise scrubbing 
reduces storage requirements and increases efficiency of the call identification process.

Multiple automated methods can be used to remove extraneous noise. At its core, the noise scrubbing process represents an 
inherent balancing act between removing non-bat sounds and low quality bat echolocation calls. An optimized noise scrubbing 
process will result in retention of recordings of bats potentially identifiable to species while retaining a trivial number of non-bat 
recordings. Achieving this balance will depend on the software employed, the parameters specified and the recording situation. 
For example, in areas with high levels of background noise, it may be necessary to remove a larger proportion of low-quality 
echolocation recordings in order to minimize the number of files that do not contain bat echolocation recordings.

Scrubbing Stationary versus Mobile Datasets

For NABat stationary acoustic monitoring, where the goal is to document species presence based on identification of 
high-quality echolocation recordings, noise scrubbing specifications should be more stringent to retain mostly high quality calls. 
Whereas for NABat mobile acoustic transects, where the goal is to document the relative abundance of each bat species, noise 
scrubbing should be more lenient, where parameters are set to retain all potential bat recordings.

In general, the software packages described here provide robust methods for separating bat echolocation calls from non-bat, 
extraneous noise and are easily customizable to be more stringent or lenient in the files that pass. However, the various meth-
ods for automated noise filtering differ. Some programs have a separate file scrubber used as a standalone step (for example, 
SonoBat [chapter 2.] and SCAN’R [not presented here]) while other software programs integrate file scrubbing into the process 
of auto ID (that is, automated species identification, see step. 3 below, for example), Bat Call Identification, (BCID, chapter 3 
and EchoClass, (chapter 4), and still others have it optionally as an integrated or standalone step (for example, Kaleidoscope, 
chapter 1). For zero-cross (ZC) files, scrubbing can also be done in AnaLookW v4.2g (Titley Scientific, 2016) (chapter 5.) using 
a filter prior to being analyzed in one of the auto ID programs. When starting with a new program, it may be helpful to review 
samples of stationary and mobile acoustic datasets post scrubbing to determine appropriate settings.

Step 3. Auto ID
The objective of using auto ID, or automated species identification, is to rapidly determine a species classification for large 

amounts of data in order to determine probable presence for the species of interest. Auto ID includes additional filtering to select 
pulses that are suitable for identification and then classify pulses and files. Classification methods vary among software pro-
grams but all rely on statistical comparisons of unknown pulses to classifiers or algorithms developed from a known call library 
of selected species. A critical part of this process is that the user must select the correct set of species to be used in this classifi-
cation process. This is an important step as the user needs to make sure that all of the possible species in the state or region are 
included in the species set (including accounting for potential range expansions), yet excluding species that are unlikely to occur. 
Note that some software classifiers may have limited species support. Resources for determining potential species lists for each 
NABat grid cell are made available at https://api.sciencebase.gov/nabatmonitoring-reports/adHocCreator?catalogId=nabat&repo
rtId=projectReview&columns=%2Fprojects@prjctname,prjctlead,owningorg,grtscellid,grts_point,batspp, and via the “Map my 
Project” feature on on an NABat partner’s project home page https://nabatmonitoring.org/#/home/welcome.

Software programs for auto ID have varying levels of customization for species classification, including the degree of 
similarity required between known (underlying reference library) and unknown recordings for a species-level identification to be 
made by the program. In general, a more conservative (which hopefully leads to an increase in accuracy) level of classification 
is desired. These specifics are included in chapters 1–5. Some programs embed species classification labels as metadata into the 
files of bat recordings (for example, SonoBat, Kaleidoscope Pro, BCID, and AnaLookW). Metadata formats are evolving; cur-
rently not all metadata written to a file by one program will be read by another program. Some software allows you to access and 
view files with auto ID metadata from within the software (SonoBat and Kaleidoscope Pro) while others require an additional 
software viewer be used if recordings are to be visualized (for example, AnaLookW can be used to view files that have been 
processed with BCID, EchoClass, or Kaleidoscope Pro).

https://api.sciencebase.gov/nabatmonitoring-reports/adHocCreator?catalogId=nabat&reportId=projectReview&columns=%2Fprojects@prjctname,prjctlead,owningorg,grtscellid,grts_point,batspp
https://api.sciencebase.gov/nabatmonitoring-reports/adHocCreator?catalogId=nabat&reportId=projectReview&columns=%2Fprojects@prjctname,prjctlead,owningorg,grtscellid,grts_point,batspp
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Step 4. Manual Vetting
Auto ID software programs are limited by various issues in the analysis process that can lead to inaccurate species clas-

sifications. Generally, programs are unable to account for deviations from expected call structure due to atypical bat behavior, 
approach calls, cluttered environments, presence of social calls, recorded call quality issues, multiple individual bats and (or) 
species in a recording, trends across a sequence of call pulses, and inherent overlap that exists in call metrics, pulse shape and 
(or) sequence pattern between some species. Both automated classification programs and manual vetting can also be limited by 
their underlying libraries of known calls. When there are biases in the reference library (for example, proportion of certain pulse 
shapes, under-representation of a particular species, and misidentification of recorded species), identification of unknown calls 
can also be inaccurate.

The goal of manual vetting acoustic files for NABat is to eliminate species misclassifications resulting from the automated 
identification process, because species misclassifications can lead to false-positive errors (that is, documenting that a species was 
present in a grid cell, when it was not). To meet this goal, manual vetting should focus on ensuring that auto ID classifiers have not 
misclassified files based on poor recording quality, non-search phase components of calls, recordings with multiple bats that may 
cause one or more bats to vary their echolocation outside the known norms for the species, or echolocation calls from species other 
than the species suggested from the auto ID. Manual vetting is a qualitative process that requires users with extensive experience.

General Recommendations:

• Accept the fact that not all call sequences can be, or should be, definitively identified to a species using diagnostic char-
acteristics measurable in sound viewing/analysis software.

• View the recording in “real-time” (most viewers will default to showing recordings in “compressed view”) to help visual-
ize inter-pulse intervals (the relatively long periods of silence in between call pulses). Ensure that there is a consistent 
inter-pulse interval indicating that the bat was performing a typical “search-phase” call type and not performing a behav-
ior such as an inspection or acquisition (“approach-phase” call type). Approach-phase behaviors result in call pulses 
with parameters that differ from search phase calls such as higher frequencies, broader bandwidth, and steeper slopes. 
Approach-phase pulses often show a high degree of overlap among species. To examine pulse shape parameters view in 
“compressed time.”

• Limit the potential species list for a particular acoustic survey site by the potential geographic ranges of species; if a 
species is less likely to be present and does not have large overlap in call characteristics with more common species in 
the area, include it in the analysis. Otherwise, if a species is unlikely and has overlapping call characteristics with other 
species in the area, it is likely best to not include this species in the potential species list, until there is more evidence to 
justify looking for it acoustically.

• Review a single species at a time in order to be consistent and efficient in your manual review. This can be achieved 
in some programs (for example, Kaleidoscope Pro, SonoBat, BCID, and AnaLookW) by sorting species-labelled files 
(metadata embedded in files following automated ID) and then viewing files in order by species. If sorting of files is not 
available within the automated ID software, then an associated viewer software can be used (for example, BCID engages 
AnaLookW as a viewer following auto ID), or a results output file can simply be viewed in a tabular program or data-
base (for example, Microsoft Excel file) where files can be sorted by species, and then viewed in a separate viewer (for 
example, ZC recordings analyzed in EchoClass can be manually viewed in AnaLookW).

• Review the entire sequence. Look for long call sequences, for example, those with multiple consecutive pulses in a 
sequence, especially pulses that have consistent inter-pulse intervals and consistent shapes, slopes, and bandwidths. The 
more calls with definitive features, the more confident the identification.

• You may want to examine recordings immediately before or after a file to determine if they provide any context in which 
to understand a particular pulse pattern (for example, if a bat has circled within range of the microphone, generating 
multiple files, a sequence of varying pulse shapes may better elucidate the species identification).

• Assess recordings that have a good “signal to noise” ratio (identified by crisp, clean, non-saturated oscillograms in full-
spectrum recordings) and without non-bat noise, echoes, or distortions in the call-pulses that can skew the qualitative or 
quantitative measures of the individual call pulses.

• If available, use established regional keys or rulesets for acoustic species identification (for example, see appendix A. 
Case Study: Using Rule Sets to Process Acoustic Data for USDA Forest Service Lands in Northern California).
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• Files that are manually-vetted should be assigned one of the following: a standard 4 or 6-letter species label (table 3), spe-
cies couplet (for example, MYCAMYYU, LANOTABR), frequency class (HighF, LowF), NoID, or NOTBAT (see table 4 
for species couplet, group, and frequency class labels). Whether you choose 4- or 6-letter species labels, be consistent and 
avoid mixing labels for a single species. If it is potentially ambiguous as to whether an identification label in file metadata 
is from an auto ID or manual process, a small letter prefix is an accepted method to provide clarity. (For example, mANPA 
for a manually verified ANPA file to differentiate from an ANPA species label derived through other means that may also 
be listed in the metadata [for example filter or auto ID]; see AnalookW workflow chapter 5.). If prefixes or suffixes are 
used to denote different sources of identification labels, this should be clearly stated in the data entry into NABat.

Table 2. Suggested codes for acoustic detectors. Information provided by J. Tyburec (Bat Survey Solutions, LLC).

[Binary Acoustic Technology LLC, http://binaryacoustictech.com/; Pettersson Elektronik AB, http://batsound.com/; Titley Scientific, 
2016; and Wildlife Acoustics, Inc., https://www.wildlifeacoustics.com/]

Detector Detector—Make/model/mic .type Code

BINARY ACOUSTIC AR125 recording to PC/Mac using Spect’r A125
BINARY ACOUSTIC AR125-FG recording to PC/Mac using Spect’r ARFG
BINARY ACOUSTIC AR180 recording to PC/Mac using Spect’r A180
BINARY ACOUSTIC iFR-V recording to on-board media iFRv
BINARY ACOUSTIC AcroBat Mic Array ABAR
PETTERSSON D1000x with external, cabled Mic D1Kp
PETTERSSON D1000x with on-board Mic (for example, active recording/voucher) D1Ka
PETTERSSON D240x recording direct to PC/Mac D240
PETTERSSON D240x recording to iRiver/Zoom or other Digital Recorder D24x
PETTERSSON D500x with external, cabled Mic and cone off D50o
PETTERSSON D500x with external, cabled Mic and cone on D50d
PETTERSSON D500x with on-board Mic cone on (for example, active recording/voucher) D500
PETTERSSON M500 (USB mic) cone off; recording to PC/Mac/Tablet M50o
PETTERSSON M500 (USB mic) cone on; recording to PC/Mac/Tablet M50d
TITLEY AnaBat Express with external, cabled mic ABex
TITLEY AnaBat Express with on-board mic ABeo
TITLEY AnaBat SD1 with LoF mic SD1l
TITLEY AnaBat SD1 with standard mic SD1s
TITLEY AnaBat SD2 with LoF mic SD2l
TITLEY AnaBat SD2 with standard mic SD1s
TITLEY AnaBat Walkabout with directional accessory OFF ABWo
TITLEY AnaBat Walkabout with directional accessory ON ABWd
WILDLIFE ACOUSTICS EM-Touch with external, cabled EchoMeter Mic EMTx
WILDLIFE ACOUSTICS EM-Touch with on-board EchoMeter Mic EMTo
WILDLIFE ACOUSTICS EM-Touch2, regardless of extension cabling EMT2
WILDLIFE ACOUSTICS EM-TouchPRO, regardless of extension cabling EMTP
WILDLIFE ACOUSTICS EM3/EM3+ with on-board mic EM3o
WILDLIFE ACOUSTICS EM3/EM3+ with external mic EM3x
WILDLIFE ACOUSTICS SM2Bat-192 with SMX-US Mic SM2s
WILDLIFE ACOUSTICS SM2Bat-384 with SMX-US Mic SM2s
WILDLIFE ACOUSTICS SM2Bat+ with SMX-US Mic SM2s
WILDLIFE ACOUSTICS SM2Bat+ with SMX-UT Mic SM2t
WILDLIFE ACOUSTICS SM2Bat+ with SMX-U1 Mic SM2u
WILDLIFE ACOUSTICS SM3Bat with SMX-UT Mic SM3t
WILDLIFE ACOUSTICS SM4BAT-FS with SMM-U1 Mic SM4u

http://binaryacoustictech.com/
http://batsound.com/
https://www.wildlifeacoustics.com
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Table 3. Species labels to be used when labeling acoustic files and submitting data to the North 
American Bat Monitoring Program (NABat) modified from Loeb and others (2015).

[Kaleidoscope Pro uses 6-letter labels. Regardless of whether you choose 4- or 6-letter labels, be consistent and avoid 
mixing labels for a single species. Adding a prefix to lowercased letters on species codes helps to differentiate manually 
vetted labels, m, from auto ID labels (for example, “mLANO” for label assigned to a file identified as Lasionycteris 
noctivagans through manual vetting)]

Common name Scientific name 4-letter Label 6-letter Label
Pallid bat Antrozous pallidus ANPA ANTPAL
Jamaican fruit-eating bat Artibeus jamaicensis ARJA ARTJAM
Mexican long-tongued bat Choeronycteris mexicana CHME CHOMEX
Rafinesque’s big-eared bat Corynorhinus rafinesquii CORA CORRAF
Townsend’s big-eared bat Corynorhinus townsendii COTO CORTO
Big brown bat Eptesicus fuscus EPFU EPTFUS
Spotted bat Euderma maculatum EUMA EUDMAC
Florida bonneted bat Eumops floridanus EUFL EUMFLO
Greater bonneted bat Eumops perotis EUPE EUMPER
Underwood’s bonneted bat Eumops underwoodii EUUN EUMUND
Allen’s big-eared bat Idionycteris phyllotis IDPH IDIPHY
Silver-haired bat Lasionycteris noctivagans LANO LASNOC
Western red bat Lasiurus blossevillii LABL LASBLO
Eastern red bat Lasiurus borealis LABO LASBOR
Hoary bat Lasiurus cinereus LACI LASCIN
Southern yellow bat Lasiurus ega LAEG LASEGA
Northern yellow bat Lasiurus intermedius LAIN LASINT
Seminole bat Lasiurus seminolus LASE LASSEM
Western yellow bat Lasiurus xanthinus LAXA LASXAN
Mexican long-nosed bat Leptonycteris nivalis LENI LEPNIV
Lesser long-nosed bat Leptonycteris yerbabuenae LEYE LEPYER
California leaf-nosed bat Macrotus californicus MACA MACCAL
Pallas’ mastiff bat Molossus molossus MOMO MOLMOL
Peter’s ghost-faced bat Mormoops megalophylla MOME MORMEG
Southwestern myotis Myotis auriculus MYAR MYOAUR
Southeastern myotis Myotis austroriparius MYAU MYOAUS
California myotis Myotis californicus MYCA MYOCAL
Western small-footed myotis Myotis ciliolabrum MYCI MYOCIL
Long-eared myotis Myotis evotis MYEV MYOEVO
Gray myotis Myotis grisescens MYGR MYOGRI
Keen’s myotis Myotis keenii MYKE MYOKEE
Eastern small-footed myotis Myotis leibii MYLE MYOLEI
Little brown myotis Myotis lucifugus MYLU MYOLUC
Arizona myotis Myotis occultus MYOC MYOOCC
Northern myotis Myotis septentrionalis MYSE MYOSEP
Indiana myotis Myotis sodalis MYSO MYOSOD
Fringed myotis Myotis thysanodes MYTH MYOTHY
Cave myotis Myotis velifer MYVE MYOVEL
Long-legged myotis Myotis volans MYVO MYOVOL
Yuma myotis Myotis yumanensis MYYU MYOYUM
Evening bat Nycticeius humeralis NYHU NYCHUM
Pocketed free-tailed bat Nyctinomops femorosaccus NYFE NYCFEM
Big free-tailed bat Nyctinomops macrotis NYMA NYCMAC
Canyon bat Parastrellus hesperus PAHE PARHES
Tri-colored bat Perimyotis subflavus PESU PERSUB
Brazilian free-tailed bat Tadarida brasiliensis TABR TADBRA
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Table 4. Species couplet, group, and frequency class labels recommended for labelling files with recordings of species that are 
acoustically similar and can occur sympatrically (adapted from Loeb and others, 2015). Also included are labels for files without bat 
recordings (NOTBAT) and for files that contain a bat pulse, but no grouping or user-defined category applies. While this is not an 
exhaustive list, we recommend you try to use these labels for consistency, but document any additional user-defined categories you 
use and submit to the North American Bat Monitoring Program (NABat). For consistency, always place the species names making up 
a couplet label in alphabetical order.

Common name Scientific name Label

Pallid bat, Big brown bat Antrozous pallidus, Eptesicus fuscus ANPAEPFU

Big brown bat, Silver-haired bat Eptesicus fuscus, Lasionycteris noctivagans EPFULANO

Western red bat, Canyon bat Lasiurus blossevillii, Parastrellus hesperus LABLPAHE

Eastern red bat, Tri-colored bat Lasiurus borealis, Perimyotis subflavus LABOPESU

Eastern red bat, Little brown bat Lasiurus borealis, Myotis lucifugus LABOMYLU

Eastern red bat, Seminole bat Lasiurus borealis, Lasiurus seminolus LABOLASE

Silver-haired bat, Mexican free-tailed bat Lasiurus noctivagans, Tadarida brasiliensis LANOTABR

Hoary bat, Mexican free-tailed bat Lasiurus cinereus, Tadarida brasiliensis LACITABR

Long-eared or Keen’s myotis, and Northern bat Myotis evotis, Myotis keenii, Myotis septentrionalis LEMY 

California bat, Yuma bat Myotis californicus, Myotis yumanensis MYCAMYYU

Not a bat NOTBAT

Bat, but no grouping or user-defined category applies NoID

User-defined categories

User-defined frequency class Various species with pulses that have a minimum frequency 
of approximately 15–25 kHz.

25k

User-defined frequency class Various species with pulses that have a minimum frequency 
in the range of 35–45 kHz.

40k

User-defined frequency class Various species of Myotis with pulses that have a minimum  
frequency in the range of 35–40 kHz.

40kMyo

User-defined frequency class Various species with pulses having a minimum frequency 
lower than ~30 kHz.

LowF

User-defined frequency class Various species with pulses having a minimum frequency 
higher than ~30 kHz.

HighF

For Stationary Point Acoustic Data

• Because the goal is to determine site occupancy for each species, examine and manually ID at least one high quality, con-
fidently identified recording per species per detector per night (that is, a voucher file) that was identified using an acous-
tic ID program. Where possible, select noise-free, long duration call sequences that can be confidently distinguished from 
conspecifics. 

• High quality recordings generally result from a loud signal as a bat approaches closer to a microphone. Some potential 
indicators of higher quality recordings for some species (for example, Myotis spp.) include high bandwidth calls. High 
bandwidth indicates that the bat has approached the microphone close enough for high frequencies to be recorded. Close 
approach of bats can also be assumed in the presence of harmonics (in full-spectrum recordings), but note that some calls 
may be oversaturated if the bat approached the microphone too closely (as seen in clipped, or “squared off,” oscillograms 
and the presence of aliasing, instead of true harmonics); sequences with oversaturated pulses should not be considered in 
the analysis process.
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• When corroborating automated species identification, focus your review on low clutter, search phase calls, and take pre-
cautions to avoid using approach phase calls, feeding buzzes, and social calls for most species.

• High quality recordings for auto ID have consistent inter-pulse intervals indicative of typical search-phase behavior. 
Be careful not to include approach phase calls when a bat is responding to an object in its flight path, as these calls take 
on a different shape that is generally less desirable for differentiating species, and can confound auto ID.

• Recordings should have been made in relatively uncluttered environments, however, low clutter calls can be difficult 
to obtain. For example, even when detectors are placed far from buildings, dense vegetation, or other hard surfaces 
bats often produce high clutter sequences when approaching the ground or in close proximity to other bats or while 
checking out the microphone if it is a novel item of interest on the landscape.

• Look at the entire sequence in both “compressed” and “real time” views. This will help you see the whole picture (for 
example, multiple bats and or species in the recording or non-search phase calls, indicating the types of convergent 
approach-phase and acquisition-phase call types that all bats are capable of producing).

• Adjust filters, thresholds, and other viewer settings as needed.

• If possible, play the recording in real-time or time-expansion to listen for a consistent cadence between call pulses.

• Examining files within a short period of time (for example less than 2 seconds) immediately prior and following the 
file of interest, may add context to better identify the species.

• To expedite review, focus manual vetting efforts on call sequences that were assigned an automated species identifica-
tion. These files are more likely to contain high quality call sequences, unlike the files that did not receive an automated 
species identification. Spreadsheet outputs can be sorted in order of auto ID confidence by looking at the number of call 
pulses that contributed to the identification. In this way the longest call sequences and decisions most likely to be correct 
are presented first.

• Review auto ID files that have been assigned to a given species category. Confirm species identification for a minimum 
of one file per species per night (voucher file).

• For example if an auto ID assigns a file a label of Species X because all 40 pulses in the sequence are assigned to that 
species, then this would be your voucher file for that species that night. If it is assigned to Species X but only 20 of 40 
pulses matched to this species label, and the other 20 assigned to Species Y for which you think the sequence could 
equally be either species due to a lack of any diagnostic features, then you might consider a species label XY. Then 
continue to review other files that were strongly assigned the Species X label until one is found that represents a good 
voucher file. If a species’ identification cannot be manually confirmed by examining the files with the highest auto ID 
confidence scores, you may also want to examine high quality recordings that were not assigned a species-specific 
auto ID label (for example, “NoID”). This is because sometimes the presence of more than one bat in a recording can 
confound auto-identification, despite a high quality recording.

For Mobile Transect Acoustic Data

• The goal for collecting mobile transect acoustic data for NABat is to evaluate relative species abundance. Therefore, manu-
ally vet all files, focusing first on the files that were assigned an automated species identification, as these are likely to be of 
higher quality. Sort the files by species and use the same criteria as described above for stationary point acoustic datasets.

• For files that did not receive an auto ID (that is, file-level classification results were left blank, or labeled HighF, LowF 
or NoID), if possible, apply filters or a sort function to enable like recordings to be viewed in series. For example, some 
auto ID software provides a suggestion of species pulse shapes that may be present in a file even if an auto ID could not 
be achieved. Alternatively, use the general call shape and characteristic frequency to sort “No ID” files by phonic group 
so that you have fewer species to consider at one time in the manual vetting process. For example, all low frequency bats 
may be viewed in series before all high frequency bats.

• When appropriate, assign a label to “No ID” files, preferentially using couplets, or categories that contain only two spe-
cies (for example, LABOMYLU for pulses that have minimum frequencies ~40 kilohertz (kHz) but undulate up and 
down to some extent); recordings that could be of more than two possible species will receive a generic group category 
such as “Low Frequency bat” (for example, LowF or 25k Hz).
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• Because the goal of transects is to determine relative species abundance, it is also important to identify recordings that 
contain more than one individual bat and (or) species. Be sure to assign multiple labels as appropriate.

The Manual Vetting Process

1. Assess call sequence quality.
There are cases when auto ID is questionable due to reduced call quality. The presence of the following quality issues likely 
impact the effectiveness of auto ID software. Downgrade the species identification to a species group if one or more of the fol-
lowing issues exist.

• Excessive noise.

• Classifier chose inappropriate calls (pulses) for classification (for example social calls, quiet/out of range calls), 
included noise as part, or in place of a call, or used non-search phase or high clutter calls.

• Identification is confounded by multiple species or individuals present in the call sequence.

• Insufficient number of pulses present for confident identification.

• Destructive interference caused by echoes.

2. Examine call sequence and call characteristics.
If the auto ID is correct, the basic measures of the calls and sequence (for example characteristic frequency, duration, 

slopes, call intervals, and so forth) should be within the typical ranges observed for that species. Sometimes these call character-
istics are measured incorrectly by the auto ID software, leading to assignment of a pulse sequence of an unlikely species. When 
the call characteristics are not within the range typically observed for the species identified, downgrade the species identification 
to a species group.
3. Look for evidence of alternative species identification.

Many call sequences have characteristics that fall within the ranges of multiple species. Depending on the potential species 
present, look for any evidence that the recording is actually of another species. Appendix C provides a “Bat Auto ID Species 
Confusion Matrix” as a quick look-up guide indicating which species are commonly confused by auto ID software. If there is 
strong evidence of another species, or a high degree of ambiguity (for example, 50 percent of the pulses match Species X, and 
50 percent match a highly similar Species Y), downgrade the species identification from the auto ID to a species group “XY” 
(for example, EPFULANO). If there is no evidence of another species, and the recording is of a high-quality bat pass, accept the 
auto ID as correct for that file. However, auto ID software is currently evolving, and there are known cases of areas where one 
species might repeatedly be called another species. There are many reasons why this might be the case, such as regional differ-
ences in some species echolocation repertoires that may not be reflected in underlying libraries or unreliable known calls in a 
program’s library. If the expert analyst can provide suitable justification for changing a species identification from auto ID to 
another species label, then such justification can be provided in an appended note, such as in the file metadata.
4. Look for evidence of multiple individuals in the file.

Depending on how the detector was deployed in relation to surrounding habitat features, flight paths, and so forth, passive 
recordings (from stationary point surveys) can include multiple individuals in a file. This is especially true if the microphone is 
located near a potential roost. Sometimes you can identify new roosts, or night roosts, acoustically by such recordings, so these 
instances are important to document. For example, in a passive dataset, a note in the metadata might be used to indicate there are 
many bats, or a suspected/known roost, and so forth. This should also be included in the submission of covariate information to 
NABat.

If multiple bats occur in a single recording from a mobile driving transect, it is important to tally the number of individu-
als. This is best done by including two labels for each file. Using software that enables metadata to be stored within the file, 
there should be one label per individual, even if the label is the same. For example, in Kaleidoscope, AnaLookW, or SonoBat 
the file “5867_NW_20160712_210932” containing two bats, each identified as big brown bat or silver-haired bat, would have 
the following species labels: EPFULANO,EPFULANO, where a the second species label is manually entered and preceded by 
a comma with no spaces. Note that some software packages tally labels for you (for example, “Countlabels” tool in AnaLookW 
would provide a tally and show “2 EPFULANO” for the file 5867_NW_20160712_210932 in the above example), however, this 
is not the desired format for NABat data entry.
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Step 5. Submit to NABat
The following steps are required for submitting acoustic monitoring data to NABat.

1. Request an Account on the NABat website by visiting https://nabatmonitoring.org/#/home/welcome and clicking on 
“Request an Account”. Once you have created a user profile and password you, must log in to gain access to your home 
page “My NABat Projects” with a list of your NABat projects.

2. Create a New NABat Project by visiting https://nabatmonitoring.org/#/home/welcome, logging in, and clicking on “My 
NABat Projects.”

 A. A list of current projects will appear (for new users this list will be blank unless another Project Leader has added you 
to an existing NABat Project.) Click “Add New Project.”

 B. Enter required project information including Project Name, Owning Organization, and Project Description. Identify 
your role in the project. If you would like to allow other existing NABat users (that is, those with registered accounts 
on https://nabatmonitoring.org/#/home/welcome) to access your NABat, click “Add User” and identify their role in the 
project. 

 C. If all or some of your projects follow the NABat priority sample design (that is, selecting grid cells following GRTS 
order), click “Cell Selection Tool” and follow the tool instructions to identify your NABat grid cells. Remember to 
provide reasons for not selecting potential grid cells in your study area or jurisdiction.

 D. If your survey locations (for example, caves, mines, stationary acoustic point locations, mobile acoustic routes) were 
established prior to NABat (legacy data) or selected without consideration of the NABat sample design (found data), 
answer ‘yes’ to this sample design question and enter grid cell numbers manually. Also, indicate which survey types 
were conducted in each of the grid cells. 

 E. Click “Save Project.”

3. View Project page by clicking on the name of your project on your home page (login is required).

4. Download the NABat Project Database (Microsoft Access, .accdb file) specific to your project by clicking “Download 
NABat Project Database”. It is important that you DO NOT ALTER THE NAME OF THIS FILE. Each NABat Project is 
assigned a unique Project Key (see example above), which is automatically generated upon project creation and used in 
the naming of your NABat Project Database file. Altering the file name of your NABat Project Database will make it dif-
ficult to ensure that your database is linked to your project upon submission. The NABat Project Database can be used to 
enter data for all five NABat survey types (that is, Stationary Point Acoustic Surveys, Mobile Transect Acoustic Surveys, 
Internal Winter Hibernaculum Surveys, Internal Summer Maternity Colony Surveys, and Emergence Count Surveys). 
For acoustic surveys, users will need to provide the names and versions of software used for species identification. 
For directions on how to use the NABat Project Database download the “NABat Project Database User Manual” from 
https://nabatmonitoring.org/#/tools. Currently, using the NABat Project Database is recommended for submitting your data 
to NABat, however, additional pathways for data submission will become available on your Project page.

5. Submit data to NABat by clicking on “Choose File” on your project page. Once acoustic files have been processed (that 
is, bat echolocation data have been identified to species following guidance in this document) and data are entered into 
your NABat Project Database, upload the following three items.

 A. Summary table of acoustic files: This table is provided as output by auto ID software (.xlsx or .csv file formats are 
acceptable) and should include a column indicating which acoustic files were manually-vetted (see guidance below for 
details).

 B. NABat Project Database

 C. Acoustic files (.wav, .wac, and (or) .zc file formats). See step 1 (Attribute Acoustic Files section of this document) for 
guidance on naming your acoustic files. Note that the ability to upload acoustic files will depend on the speed of your 
internet connection and may not be possible if your connections is slow. For this reason, please prioritize submission 
of “voucher files” (that is, acoustic files that have been manually vetted). For stationary point acoustic data, a voucher 
file is a single file providing evidence that a species was present at a single detector, within a single night. For mobile 
transect acoustic data, every file is considered a voucher and should be uploaded. If uploading acoustic files via the 
internet is not possible, contact Brian Reichert at breichert@usgs.gov for mailing instructions.

https://nabatmonitoring.org/#/home/welcome
mailto:breichert@usgs.gov
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Chapter 1. Processing Acoustic Data Using Kaleidoscope Pro Version 4.3.2

By Cori Lausen2 and Susan Loeb3

2Wildlife Conservation Society Canada
3USDA Forest Service

Step 1. Attribute Files

• Ensure that minimum attribute data are included for each file. (See step 1, Attribute Acoustic Files that follows the Intro-
duction of this report for more detail on attribution data).

• If input is in Anabat ZC files (Titley Scientific v.4.2g, 2016), attribute files with metadata in AnaLookW using the Global
Header Change (see AnaLookW Workflow), or in Batch Tab of Kaleidoscope Pro (KSPro) (see the next step).

• If input is full spectrum (FS) files (for example, .wav file format), attribute files with metadata in the Batch Tab (by
selecting “Prepend notes to output medadata”) in the dropdown menu on the left side of the tab (that is, “INPUTS”
section). Note: Metadata formats are currently evolving toward a unified system called “GUANO” which will be read-
able across all software programs that recognize GUANO metadata (for example, SonoBat). The process for entering
metadata into GUANO will change in future versions of KSPro. In its current version (version 4.3.2), enter metadata in
GUANO format by typing the following information into the end of the notes field.

GUANO|Version:  1.0
NABat|Grid Cell GRTS ID:  54405
NABat|Site Name:  SW

These metadata values must each be on separate lines, and the fieldnames are spelling and case sensitive. In the example above, 
54405 is the GRTS ID of your grid cell, and the detector was deployed in the NW quadrant of the grid cell. 
Continue through steps 2 and 3 before processing files.

Steps 2 and 3. Noise Scrubbing and Auto ID

1. On Batch Tab, enable noise filtering—either delete or move to noise folder

2. On Batch Tab select input and output directories for each of the INPUT and OUTPUT sections. To do this use the
“Browse” buttons. The OUTPUT folder must not be embedded within the INPUT folder or you will receive an error mes-
sage.

3. Choose output file type. Click either WAV files or ZC files as appropriate.

• If input is WAV files and you plan to review files in Kaleidoscope or other full spectrum recording format (FS) viewer,
click WAV as the output file type.

• If input is WAV file and you plan to review in AnaLookW or further analyze in Echoclass or BCID, click ZC as the
output file type.

• If input is ZC file, click ZC as the output file type.

• Be sure to check off the box to include subdirectories if the input data consists of subfolders.

• Optional (but highly recommended if your files are not already sorted into “night” folders): Under the Create Subdirec-
tories option choose “Nightly” which will sort the new files into nightly subfolders (based on “bat nights” with the date
not changing at midnight). Ignore this step if your files are already in “night” folders.

4. Go to Signal Parameters Tab.

• Minimum signal of interest should be appropriate for the expected bat community.
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• Call duration should be one to 50 milliseconds (ms) for mobile transects and 2–50 ms for stationary points. This will
ensure that all potential bat recordings are included in the mobile transect dataset (some noise files that do not contain
bats will also be included) and will potentially exclude a few bat recordings in stationary datasets but will ensure more
high-quality recordings for species identification. This is to ensure no bat files are missed in the measuring of relative
abundance in the mobile transect dataset, even though it is anticipated that more of the auto-identified files will remain
as NoID or changed in manual vetting, such as downgrading to a species group or frequency class.

• Minimum number of pulses should be three.

• Leave the maximum inter-syllable gap at its default value of 500 ms. This applies only to the cluster analysis process,
which is not part of this workflow.

• If the workflow remains within Kaleidoscope-Pro, check the Enhanced Signaling Processing box; otherwise do not
check this box.

5. Go to Auto ID for Bats tab.

• Select appropriate species for your area. Make sure to consider species that may be rare or slightly out of range.

• Select “More Accurate-Conservative” option

6. When all settings are entered, press “Process Files” button.

Step 4. Manual Vetting

1. In the results window, sort by Folder, Matching, Date, and then by Auto ID. If some of these column names do not appear
for you, select “File” => “Edit Columns” to show them. Review “Match Ratio” to confirm that this is a potentially good
file, (that is, the more calls in a sequence that match the auto ID species, the better).

2. Look at the potentially good files (high matching values) to confirm they are the species identified. You may need to adjust
the viewer settings, including viewing of ZC or FS pulses, FFT settings, brightness, and contrast, to best match your
recordings.

3. If your manual verification agrees with the Auto ID, put the species name in the “Identification” field (this will be the same
as the Auto ID, just mouse click on the Auto ID button below the “Identification” field). This will indicate to NABat that
the file has been examined and been verified. There is no need to look at more than a few files if there is agreement that
this species was present at a detector during the night in question.

4. If your manual verification does not agree with the Auto ID, put the revised species group label (or species if justification
can be provided) in the Identification field.

5. Remember that you can enter more than one species label into the Identification field. If you see another bat species pres-
ent, you can add this species label in by manually typing the label after a comma (do not use any spaces). For example,
MYOLUC,LASCIN. (This process is automated by holding the control key during labelling in later KSPro versions.)

6. Save your results file.

Step 5. Submit to NABat

See the Introduction of this report for the steps for submitting data to NABat. To easily identify voucher files that should be 
prioritized for upload through your NABat Project page using KSPro, sort, select and save manually-vetted files.
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Chapter 2. Processing Full Spectrum Acoustic Data Using SonoBat 4.2.1

By Ted Weller3

3USDA Forest Service

Step 1. Attribute Files Using SonoBat Attributer

Ensure that minimum attribute data are included for each file. (See step 1 in the Introduction of this report for more 
detail on attribution data). SonoBat Batch Attributor attributes recordings and (optional) simultaneously scrubs (identifies and 
removes) noise files.

Step 2. Noise Scrubbing using SonoBat Scrubber and Attributer

Follow these steps to remove non-bat files from dataset.
1. Output to a new directory (for example, SiteDate_scrubbed) if retention of files identified as non-bats is desired.

2. Select “Medium Scrub” option.

3. For sites with low frequency bats (less than [<]20 kHz), choose to include signals from 5–20 kHz. Low frequency bats
can include Euderma maculatum, Eumops spp., Lasiurus cinereus and Nyctinomops spp. Generally, consider including all
5–20 kHz because it is often likely that most locations will have at least one low frequency bat species. However, for sites
outside the suspected range of low frequency species, choose “exclude all signals <20 kHz.”

Step 3. Auto ID

Follow these steps to SONOBATCH the entire directory containing the recording session of interest. 
Settings: If files up to 15 s long have been recorded, as recommend in Loeb and others (2015), ensure Preferences => Max 

Segment to Process reflects this file length.
1. Select the classifier most appropriate for your location and recording conditions.

2. Use “autofilter” generally.

3. Use “autofilter-low” in areas with low-frequency bats present (Euderma maculatum).

4. Use the default settings.

5. Acceptable call quality = 0.80

6. Sequence Decision Threshold = 0.90

7. Set Maximum Number of Calls to Consider per File = 16

8. (OPTIONAL) To work with output in Excel, use “Output Legacy SonoBat Sheets” and select the “Classify?” option.
Alternatively, if manual vetting in SONOVET skip to next step.

Step 4. Manual Vetting

Manually vet the SONOBATCH output depending on objectives (stationary point vs mobile transect acoustic monitoring).
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Stationary Point and Mobile Transect Data
Follow these steps to confirm species detections per detector per night.

1. Create Project in SONOVET by adding directory containing the SONOBATCH call files.

2. In the Vetting Table add a Monitoring Night Column by right-clicking on the header bar and Insert before => SonoBat
Data => MonitoringNight.

3. In the Settings tab, sort the Vetting Table as follows. This sorts the results by night and species with the files with the
highest probability of being confirmed by manual vetting at the top.

Note: One can use “Save Layout” to quickly apply these settings to future SONOVET projects.

Figure 2. Vetting Table sorting criteria in SONOVET software.

4. For each monitoring night, confirm species ID for one file per species per night. Keep reviewing auto ID files where
“SppAcc” = species X until you confirm the species, or until you have reviewed what you would consider a reasonable
number of files (for example, if the species cannot be confirmed after review of the 10 “most likely” files, you might
assume non-detection for that species on that night.)

5. Files are displayed in SonoBat by clicking on the file row.

6. For each file reviewed, select a standard identification code in the Species Manual ID column by right clicking the Species
Manual ID cell.

7. A standard code can be a 4-letter species code, a species couplet (for example, MYCAMYYU, LACITABR), a frequency
group (for example, Q40k, Q25k) or a high/low frequency class (HighF, LowF).

8. Add custom species couplets and frequency groups using Config Manual ID Defaults.

9. Assigning files to groups helps track whether files have been reviewed.

Mobile Transect Data Only
The objective is to confirm species detections for all other files. Follow steps as above, but continue vetting all files, even 

those that have not been assigned an auto ID. This process is made easier by sorting the table by files that are likely to belong to 
the same phonic group so they can be viewed in series.

Step 5. Submit to NABat

See the Introduction of this report for the steps for submitting data to NABat. To easily identify voucher files that should be 
prioritized for upload through your NABat Project page in SonoBat, sort, select and save manually-vetted files.
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Chapter 3. Processing Acoustic Data Using Bat Call Identification ver. 2.7d (BCID)

By Ryan Allen10

10Bat Call Identification, Inc.

Step 1. Attribute files

In BCID (Bat Call Identification, v2.7d, 2015), data can be attributed in two ways—both have advantages and 
disadvantages.
1. Use Header tab in BCID—Anything that you type in this area will appear in the header of the ZC file for any file in your 

tree that passes the filter. The advantages are you can set the filter to look for something very specific and label files as 
such and can label an entire file tree at once. The disadvantage is that files that do not pass the filter (that is, noise files, 
poor quality calls) will not be labeled. (However, this can save a lot of processing time.)

2. Use Global Header Change in AnaLookW—You can change the headers of the file using the global header change 
options in AnaLookW. Make sure you “MARK” all files first, as changes will not take place on unmarked files (see 
chapter 5). This method will allow you to change all the files including noise files, but may be more time consuming.

All global positioning system (GPS) data should be entered into files using AnaHead located within AnaLookW at this time. 
BCID will work to include this in the near future making it easier on the user.

Data files can be arranged in any manner the user sees fit as long as all of the files to be analyzed are nested in the file 
directory selected to analyze the current “chosen” folder. We recommend a format of Grid Cell/Detector/Date for NABat.

Step 2. Noise Scrubbing

While the noise filtering process in BCID is relatively integrated there are some options that the user should be aware of. 
First, the user can change any of the parameters in the noise filter that they wish, but if this is done it should be done in a manner 
that is highly thought out. In addition, BCID recommends reporting significant changes in a header data type format. The filter 
that was used can be read on the last tab of the BCID output file.

The most important items that users can adjust within the filter are the Minimum Number of Calls to be considered in order 
to make an identification and the Min DP (Minimum Discriminant Probability). Increasing both or either of these numbers will 
have an effect on both false and true positives. For NABat use a minimum of three calls.

Given the guidance in this document, BCID would recommend experimenting with these numbers, especially the Min DP 
as increasing it from the default of 0.00 can help reduce false positives because the number is based on several values that deal 
with call quality.

If you would like to view the files as the software does in order to test your filter, you can create the filter under the filter tab 
within the BCID software and then load the filter into AnaLookW and view your files. This can also be useful for moving your 
“noise” files into separate folders.

Step 3. Auto ID

If you are using full spectrum files you must first run them through the wav to zero cross converter within the BCID soft-
ware or other similar software packages.

The most important thing you can do is to choose the correct species for your area. Under the species tab in BCID you can 
choose a state or territory and then all of the species known to occur within that region will appear. Those that are widespread 
will be checked, those that are geographically isolated will be left unchecked. Those that are greyed out are not available for 
identification in the software.

We recommend setting the Create ANL file under the Advanced tab. This will allow the user to view the files in the next 
stage (manual vetting) by species label in AnaLookW. In addition, there is the option of adding the predicted species label into 
the header of the file by checking the corresponding box.

The final step is to use the Add Folders to Project button under the Project tab. You will select the folder at the highest level 
you would like your files analyzed. All files within and below the chosen folder will be included in the analysis and any labeling, 
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etc. that you have chosen for the software to perform. Once all files are chosen, return to Project tab and click Analyze files. This 
will produce a .txt document will all the files, IDs, etc. and a Microsoft Excel file with three tabs: (1) all of the files broken down 
by folders, (2) summaries of all folders, and (3) settings used, including the filter parameters and species selected.

Step 4. Manual Vetting

The easiest method of manual vetting files in BCID is to use the ANL file that can be created by BCID under the 
“Advanced” tab and opened in AnaLookW. This will allow you to open a virtual folder of all files that BCID has classified to 
species and quickly review them to see if any of the files are consistent with calls produced by that particular species. Adjust 
header labels following guidance for manual vetting described above.

After manually vetting a dataset, one could re-run the auto ID, testing various values of the Min DP setting to determine 
the Min DP value that produces the results most similar to your manual vetting for a particular site, geographic region, etc. This 
could be informative for future analyses of datasets from this site. It is important to understand that both the software and man-
ual vetting can be incorrect on occasion. The goal is to find the number where one can achieve the largest volume of data while 
ensuring the accuracy of the results. Once this number is arrived at, the software can be run using this number and the robustness 
of the results should be much more reliable.

Step 5. Submit to NABat

See the Introduction of this report for the steps for submitting data to NABat. To easily identify voucher files that should be 
prioritized for upload through your NABat Project page in BCID, sort, select, and save manually-vetted files.
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Chapter 4. Processing Zero-Cross Acoustic Data Using EchoClass v 3.1

By Eric Britzke4

4U.S. Army Corps of Engineers

The following describes a recommended workflow using EchoClass for processing acoustic data for the North American 
Bat Monitoring Program (NABat) where data were collected or converted to zero-cross files (*.00# file format).

Step 1. Attribute files

The first step in this process is attaching metadata to the files. The current version of EchoClass relies on the directory 
structure to provide information on the files instead of adding this metadata to the individual files (Britzke, 2012). Thus, in order 
to attach metadata to the individual files, use process included in chapter 5 (Recommended Workflow for Processing Zero-Cross 
Acoustic Data using AnaLookW).

Tips for organizing your data
The following information is taken from Britzke (2012). The data file structure must have at least two levels (no maximum) 

of folders for the program to run. Additionally, the structure must be consistent throughout for each run of the software. Keep 
the folder names short and do not include the “&” symbol in any folders or filenames. All of the recorded call files must be in a 
folder named with 8 numeric characters (for example, 20120805). This can either be the date that the files were recorded or can 
be a single download data as EchoClass uses this information to look for files but reads date data from the individual file. As the 
output of the analysis software includes information from the directory structure, (following the example below) the directory 
structure will populate the output with project and site information that is then ready for inclusion in a report. 

Example file structure
Bats2012
 Project1
 Grid Cell1
 Site1
 20120601
 20120602
 Site2
 20120701

• If you select the folder 20120601 the output file will be empty.

• If you select the folder Site1 you would get results from all folders named with 8 numeric characters under the Site1 
folder (for example, 20120601 and 20120602).

• If you select the folder Project1 you will get results from all of the folders named with 8 numeric characters in all of the 
sites under the Project1 folder (for example, 20120601, 20120602, and 20120701).

• If you select the folder Bats2012 you will get results from all of the folders named with 8 numeric characters in all of the 
sites of all of the projects under the Bats2012 folder.
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Global Positioning System (GPS) Information

Mobile Transect Acoustic Monitoring

• Make sure the gps.txt file downloaded with CFC read is located within each date folder.

• GPS_and_Sunset_Master.xls excel spreadsheet must be placed in the data directory, but can remain empty. For GPS data, 
the sheet must be entitled Mobile GPS Locations.

• Geographic coordinates for each bat file will be added to the latitude/longitude columns of the UserID output.

Stationary Point Acoustic Monitoring

• The latitude and longitude of each site must be entered

• Any higher data structure must also be entered

Grid Cell Site Latitude Longitude

Grid Cell1 Site1 11.1111 22.11111

Grid Cell1 Site2 11.2222 22.22222

Table 5. Example stationary GPS Locations for 
running Bat2012 in the above data structure

Sunset/Sunrise Times

• For sunset/sunrise the sheet must be named Sunset and Sunrise Times.

• For each Site/Date, enter the appropriate Sunset and Sunrise Times in 24-hr clock notation format

Grid Cell Site Date Sunset Sunrise

Grid Cell1 Site1 20120601 20:45 05:45

Grid Cell1 Site1 20120602 20:46 05:43

Grid Cell1 Site2 20120701 20:35 06:15

Table 6. Example sunset and sunrise times for running Bat2012 in the 
above data structure:
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Steps 2 and 3. Noise Scrubbing and Auto ID

Analyzing data with EchoClass is straightforward as there are few options that can be selected by the user. This was done 
to improve accuracy, repeatability, and consistency in the results among datasets. When the EchoClass software is launched, the 
user interface in fig. 3 appears.

Figure 3. Startup user interface for EchoClass software (from Britzke, 2012).

1. Select the Browse button and navigate to the appropriate directory (see examples above).
Chose the appropriate species set. If a species is not listed in a set it will not be an option for identification in this analysis. 

Thus, if that species is present it will be misclassified as a species that is listed. Because of this, the user should include all pos-
sible species which might be present in the area.
2. Click GPS information if the GPS data are provided in a specific format (table 5). This will result in location information 

being included in the output file.

3. Click Sunset/Sunrise Times if you want the activity metrics to be calculated. The user must provide the sunset and sunrise 
times for each night for the given location (table 6). This information will also be reported in the results output.

4. Click the Process Data button.
As the program runs a series of popups will appear and disappear. Once completed, a Microsoft Excel file titled “User ID 

Report” will be created in your selected working directory (the folder selected in with the browse button).

Supplemental Data Options
For the following options to function correctly, the GPS_and_Sunset_Master.xls Excel spreadsheet must be placed in the 

data directory selected to run the program on (that is, if Project1 is selected, the excel sheet must be located there as well).

Step 5. Submit to NABat

See the Introduction of this report for the steps for submitting data to NABat. To easily identify voucher files that should be 
prioritized for upload through your NABat Project page in EchoClass, sort, select, and save manually-vetted files.
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Chapter 5. Processing Zero-Cross Acoustic Data Using AnaLookW 4.2n  
(March 16, 2017)

By Cori Lausen2

2Wildlife Conservation Society Canada

The following chapter describes a recommended workflow using AnaLookW for processing acoustic data for the North 
American Bat Monitoring Program (NABat) where data were collected or converted to zero-cross files (.zc file format).

Step 1. Attribute Files

1. Ensure that minimum attribute data are included for each file. (See step 1 in the Introduction of this report for more detail 
on attribution data).If waypoints are not already included in your files, add GPS coordinates to stationary point acoustic 
data using Anahead or to transect datasets using GPS Integration Wizard prior to analysis.

• Using Anahead (Click on Tools –> Anahead); select your folder and highlight all the files; positions; enter manually; 
enter the latitude and longitude in World Geodetic System 1984 (WGS84) datum.

2. (OPTIONAL, but recommended) Sort your data into nightly subfolders. This is generally advantageous because the sta-
tionary point acoustic data for NABat are analyzed by species presence per detector per night. For example, one potential 
hierarchical folder organization scheme includes assigning a single folder per GRTS ID with subfolders for each detector 
and mobile transect. Within each detector subfolder there should be nightly subfolders.

• If you used a Titley Scientific detector, this is most easily achieved at the time of download (for example CFCRead for 
Anabat has a check box for “split nights”).

• If you are using an auto ID software prior to using AnaLookW, many programs give you the option to sort your files by 
“bat-night.”

• Any dataset can be split up by night using Tools => Folder => Split Folder in AnaLookW.

3. Add Location data to headers of files if this information is not already in the file metadata. It is highly recommended that 
you carry out this step even if this information is present in the filenames.

• In AnaLookW, perform the following for each folder: FILE =>Mark All Files, EDIT =>Global Header Change. Add 
into the LOC field the Grid Cell GRTS ID and Site Name. For Transect folders, add Grid Cell GRTS ID Transect.

• If you know how to run a scan, you can send each detector’s files (all nightly subfolders) through a single filter scan 
using a “blank” filter so that all files are listed in a list file (virtual subfolder, much like a playlist in iTunes). You can 
then open the resulting .anl file in AnaLookW and do a global header change on all files here, thus putting info into the 
header of all files in all nightly subfolders, instead of having to do each folder separately.

Step 2. Noise Scrubbing

Follow these next steps to remove non-bat files from your dataset.

Option 1: Kaleidoscope or Kaleidoscape Pro

• Run the files through Kaleidoscope or Kaleidoscope Pro (KSPro). You do not need to do any file conversion or auto ID, 
simply select to move noise files out of the dataset. Be sure to select the appropriate criteria for the noise scrubber (see 
KSPro workflow).
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Option 2: AnaLookW

• In AnaLookW, apply an “AllBats” or customized AntiNoise filter (see appendix B “Using Filters in AnaLookW”). Run 
a scan (Filter =>Scan) using the selected filter across a copy of the dataset (folder tree), setting the output to generate a 
list file (only check the ANL list box). By opening the resulting .anl file in AnaLookW File Selector, you can mark all the 
files which passed the filter, reverse the marks and then delete (or move) all the files now marked (the files which didn’t 
pass the filter).

Step 3. Auto ID

Use one of the following three options to obtain ZC files with species labels, using one or more of the following options:

Option 1: Species Labels are Embedded in Files as MetaData During the Auto ID Process

SonoBat

• SonoBat is used for files that start as full spectrum. SonoBat will place a species label in the file metadata that should 
appear in AnaLookW once the full spectrum file is converted to ZC format (see next step). The auto ID label will be 
in the Species field of the Header data; or if you have selected for SonoBat to change the filename, then the species 
label will appear at the end of the filename. In the latter case, it is desirable to leave the filenames with SonoBat Species 
Labels as this may be the only record you will have of what this auto ID program assigned to a file. Subsequent manual 
vetting in AnaLookW will place metadata into the species field that will override the auto ID in the final results file.

• After running the auto ID process in SonoBatch, you must convert full spectrum files to ZC files in order for them to be 
read in to AnaLookW. Do this in KSPro, BCID, or in newer versions of AnaLookW (TOOLS => CONVERTER => WAV 
TO ANABAT). Note: Appended species labels in filenames from SonoBat are scrubbed off the end of the filename in 
KSPro 4.3.2.

Kaleidoscope Pro

• Kaleidoscope Pro (KSPro) can be used for any recording file type. Before processing files with the auto ID option, check 
the appropriate file type checkboxes in the Batch tab. (for example, wav as input, ZC as output). The auto ID process 
will place a species label in the ZC file metadata which will be seen in the Species field of the Header data once in Ana-
LookW. There will also be information in parentheses about the auto ID (for example matching pulses; alternate IDs—
this will depend on the version of KSPro that has been used).

Bat Call Identification (BCID)

• BCID can be used for any recording file type. If you use full spectrum files, you will need to first convert them to ZC 
within the program. The auto ID process of BCID will place a species label in the ZC file metadata (in the Species field 
of the Header data, appended with -bcid). (see chapter 3. Processing Acoustic Data Using Bat Call Identification (BCID 
ver.2.7d)).

Option 2: Species Labels Are Embedded in Files as Metadata Following Application of Filters

• Follow instructions in appendix B Additional “Guidance for AnaLookW.”
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Option 3: Species Labels Are Provided in an Excel Spreadsheet

• The Excel spreadsheet provided as output from auto ID software (for example spreadsheet produced by EchoClass—see 
the EchoClass workflow in chapter 4) can be referred to during manual vetting of the files using AnaLookW as a viewer. 
Manual vetting will entail making changes in the Excel spreadsheet after viewing each file.

Step 4. Manual Vetting

To carry out manual vetting, follow the ruleset laid out in step 4 (after the Introduction) of this report. If you obtained 
files via Option 3 above, view each file in AnaLookW and adjust species labels as appropriate in the Excel spreadsheet. If you 
obtained files using Options 1 or 2, proceed with the following steps for manual vetting.
1. Ensure the Species List is visible. Check the option in View => Species List. This will allow you to add a species label to 

the metadata of each file by clicking a single button. Load or create a species list using one of the following options.

• Option 1: Load a Species List

• Click the LOAD button to the right of the species label buttons.

• Option 2: Create or edit a Species List 

• Right-click each button and enter a 4-letter species code (table 3) or up to 8 letter frequency group or high/low class 
label (table 4).

• Select SAVE AS to save your species list.

• Tips for Species Lists

• Include group labels appropriate for your bat community (table 4).

• Prefix lowercased letters on species codes so it is possible to differentiate manually vetted labels, m, from auto ID 
labels (for example, “mLANO” for label assigned to a file identified as Lasionycteris noctivagans through manual 
vetting).

2. Load a file from your dataset. If your files are organized by detector and by nightly subfolders, start with night one of 
detector one.

3. FILE=> DISPERSE.

1. Choose one of the following methods.

• Method 1: Select current folder. This will create a sorted .anl file just for the nightly folder you have selected. You 
will need to repeat this step for each night’s folder for each detector.

• Method 2: Select a higher order folder. Include subfolders (check this box). For example, you might select to do a 
“disperse” of one detector. This means all nightly subfolders will be included in the “disperse” and you can view all 
recordings of this detector as though they were in one virtual folder together. This method involves fewer steps over-
all than Method 1, but you will have to pay attention to what nightly subfolder you are in during the vetting process.

2. Check the option for List File (.anl). Check to IGNORE PREFIXES. Then RUN. A new online software www.Ana-
craft.online will be available in 2018 which will facilitate multiple auto ID programs to be used on ZC recordings. This 
process will be different in this new program.

4. “Shift I” (or FILE => OPEN HERE) and click on Sorted.anl in whichever folder you directed the Disperse to start. 
(Sometimes you need to collapse directory and open it again to see this file—little bug! You close and reopen the folder in 
the left viewing pane using the ± button by folder name.)

5. Using CHOOSE FIELD, review each of the species categories. The goal is to manually verify at least one file per night for 
each species. Recall that the label you place into the Header Species field when you manually vet should be prepended 
with a lower case letter “m” (for manual review). Any file with an “m” before the species will assume to have been verified 
manually.



• You can also use species couplet, group or class labels up to 8 letters, such as EPFULANO, LowF, and so forth. (see 
tables 3 and 4 for more labels). Since these types of labels are not used by the auto ID software, it will be clear that 
these labels were added during manual vetting.

• Recall that you can add multiple labels separated by a comma, with no spaces. This happens automatically when you 
press more than one species list button in the same file.

6. Repeat steps 3–5 until all nights of all detectors have been analyzed.
For stationary point acoustic data, you need only confirm one file of each species each night. For mobile transect acoustic data, 
all bat files should be reviewed.

• Required for Mobile Transect data and recommended for stationary point acoustic data: reviewing the “No_ID” field. 
These files did not get an auto ID and if you used filters, also did not get triggered by a filter.

• Why are some files No_ID? Files assigned the label “No_ID” are likely poor quality, high clutter recordings. However, 
with auto ID a file is occasionally labelled as “No_ID”, even though good quality, identifiable pulses are present. This 
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Figure 4. View of folder directory in AnaLookW.
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can occur when the recorded pulses have characteristics of more than one species. However, this can also occur if two, 
equally well-recorded species occur in the same file. Identifying high quality recordings of two species in the same file 
is especially important if there are species that you think are present in your area, but have not been detected in a certain 
night’s dataset. In stationary point acoustic data, this may be the only reason to view “No_ID” bat passes.

Mobile Transect Data Only
The goal for collecting mobile transect acoustic data for NABat is to evaluate relative species abundance. Therefore, ensure 

that each bat file receives a label. If there are few “No_ID” files, then you may choose to go through all of them. If there are a 
lot of these files (for example, >100), you may instead opt to run a few filters to group the “No_ID” files into broader catego-
ries for easier vetting. For example, you could choose to run a general “40kMyotis” filter if you have one of these available. 
LOAD FILTER, then FILE => MARK IF PASS FILTER. Remember that once a filter has marked files, you can quickly jump 
from marked file to next marked file using -/= keys and select on the species button at the top to add the label “40kMyo” (or use 
GLOBAL HEADER CHANGE and label “f40kMyo”).

Download Results into an Excel Spreadsheet Format.

1. TOOLS => ANAHEAD

2. Select the folder in your dataset you want to summarize

3. FILE => DOWNLOAD.

4. Repeat 1 and 2 for all subfolders in the dataset.

5. In Windows Explorer, open up each Header.txt file that has been created in each folder/sub-folder, one at a time and copy/
paste the output into an Excel spreadsheet.

Step 5. Submit to NABat

See the Introduction of this report for the steps for submitting data to NABat. To easily identify voucher files that should be 
prioritized for upload through your NABat Project page using AnaLookW, use “Mark if Labelled” and select manually-vetted files.
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Appendix A. Case Study—Using Rule Sets to Process Acoustic Data for USDA 
Forest Service Lands in Northern California

By Ted Weller3

3USDA Forest Service

The standard for which files should be considered for manual vetting will vary by location according to how common a 
species is expected to be and how likely it is to be confused with other species at the site. Location-based rulesets can be estab-
lished to direct manual vetting towards files that require the most attention (that is, unusual species, files where SonoBat has 
lower levels of certainty in its auto ID). Rulesets can be codified to automatically assign species to files for which SonoBat has 
high levels of confidence, and assign files to frequency groups (for example HiF, Q40k) where SonoBat has low confidence or 
gleaned little information from the file. When establishing rulesets, take into consideration the expected probability of a species’ 
detection in deciding how to direct manual vetting efforts. For example, at some sites, a single species can comprise greater than 
or equal to (≥) 50 percent of the total files recorded. In this case, confirmation of this species can be based on lower levels of 
certainty by SonoBat (for example, TABR 2 of 2) than we would normally accept. Rulesets are plastic and evolve over time to 
improve accuracy of species identification and, importantly, improve efficiency with which assignments to a species or species 
group are made. Rulesets begin as regional tools and evolve into sub-regional tools as we learn more about the relative probabil-
ity of species occurring in the parts of the region studied. When appropriate, rulesets can be established for individual sites. In 
northwest California for example, two sites approximately 100 kilometers (km) apart have different rulesets. At one site, TABR 
is exceedingly common and LANO is less common, while at the other site, TABR is very uncommon and LANO is common. 
Hence we review few of the potential TABR files and more LANO files at the first site and all TABR files and very few LANO 
files at the second site. This saves time at both sites.

In the following, we describe a process for using established rulesets to determine activity levels by species and species 
groups by night in mountainous areas on USDA Forest Service land in northern California.
1. Vetting table is exported as.txt file, selecting output null as “”.

2. Exported .csv file is opened in EXCEL and a Pivot Table is inserted to summarize the data.
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Figure 5. A standard output from SonoBat summarized in Excel (Szewczak and Szewczak, 2017).
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The output table includes the number of files confirmed per night populating the species-by-night matrix. Values ≥1 will 
ultimately be reduced to presence/not-detected values for analysis. Here they represent a crude, proposed method of assigning 
confidence to species ID per night.

The following rulesets were translated into a PYTHON script (https://github.com/brendan-ward/echoclean) and pointed at 
text output from a SONOBATCH run.

• For EPFU, LANO, MYCA, MYCI, MYLU, MYVO, MYYU, and PAHE, we will generally only review files if
#Maj=#Accp≥3, files with #Maj=4 and #Accp=5, and #Maj=5 and #Accp<=7, and #Maj=6 and #Accp<=8 should also
be reviewed.

• When ANPA, COTO, EUMA, EUPE, LABL, LACI, MYEV, MYTH, NYSP, or TABR are listed in the ”1st” column,
review all files (up to 10 files per night) until at least five files per species per night can be confirmed.

The PYTHON script creates a “Species” column and an “Inspect (Y/N)” column. The species column is populated with a label: 
species, couplet (for example EPFULANO), frequency group (for example, 50k), or high/low frequency class (for example, 
HighF) according to SONOBATCH output parameters. Files without adequate information from SONOBATCH are identified 
simply as “Bat”. In some cases these have been found not to be bats, despite the file having been scrubbed in earlier steps. The 
relative proportion of files that are not bats appears to depend on site and season (for example, bird songs and insects can some-
times trick the scrubbers). If it is important to quantify the total number of files produced by bat echolocation (‘mobile transect 
acoustic monitoring’ for NABat, Loeb and others [2015]), low-quality and non-bat files are included in manual vetting efforts.
3. Files highlighted by ruleset (via the Python script) are prioritized for manual vetting.

• Output is sorted as follows:

Figure 6. “Sort” criteria used to arrange summary output in Excel.

• Sorting orders the files to be manually vetted by potential species followed by probability that they will ultimately be
assigned to that species and groups them according to other potential species in the file and frequency range.

• Each file with “Inspect=Y” is manually vetted and assigned to species or group. Manual vetting is based on compari-
son to reference files, regional guidance (with images) written by Ted Weller, and experience of the observer.

4. Following manual vetting, files are re-sorted excluding the “Inspect” column such that potential species ID’s are listed in
order of SonoBat’s guidance.

• Patterns in eventual ID’s compared to SonoBat ID’s are studied to refine the ruleset for each of the species.

5. Night of recording is extracted from the filename and used in a pivot table to create a matrix of number of files assigned to
each species or group for each night of recording.
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Appendix B. Additional Guidance for AnaLookW

By Cori Lausen2

2Wildlife Conservation Society Canada

Tips for using AnaLookW

• TOOLS => OPTIONS => DISPLAY will allow you to change colors if needed.

• TOOLS => OPTIONS => change DELAY to 300 ms (so the user can scroll through files at reasonable speed by holding 
the closed square bracket or W keys)—recommended.

• Always save files to C drive (not to desktop or My Documents), as AnaLookW does not like files that become too buried 
in a directory and the desktop is actually an embedded location in your hard drive!

• Mark all files (FILE => MARKING => MARK ALL). You then can use the button REPLACE in the top of the Ana-
LookW screen to replace a field for all marked files (for example Highfreq instead of HighF). Recall that there is no 
“undo” if you make a mistake.

• To move from file to file that has a label in species field of header (for example skipping blank species), hold “Shift” and 
press the square bracket keys “[“ or “]”.

• To skip between marked files, use the “˗“ and “=” keys

• Reverse marks as needed, in FILE => MARKING or “right-click” on file names in Anabat File Selector Window (Shift l).

• FILE => MARK IF LABELLED (only mark those files with a species label).

• EDIT => DELETE IF MARKED. (For example, you could “Reverse all marks” after marking bat files (so marked files 
are the noise files), then it is possible to move or delete files if you are confident they are all “noise” (non-bat recordings).

• You can use the “m” key on your keyboard to pull up a measuring screen. (or VIEW => MEASURES). If you use 
numeric parameters to help manually vet, you can view measurements of single pulses or averages of pulses on the 
screen using this “m” key.

• You do not need to use the “Measures” screen to evaluate “Fmin” if there are many pulses, as this could be misleading. 
Instead, hold your curser at the bottom of the call of interest and look at the number on bottom right of the screen.

• Under VIEW => OFFDOTS you can choose to visualize your “offdots”. Filters turn dots “off.” By choosing to visualize 
“offdots” you can see which dots are not passing the filter criteria.

• You can view your file in a screen next to another screen with a reference file by selecting VIEW => TILE HORIZON-
TAL (or TILE VERTICAL). You can then link both screens so they maintain the same settings by selecting the link 
screen button that looks like two overlapping squares. The screen you are in at the time of clicking the link screen button 
becomes the “Master” screen while the other screen becomes its “Slave.” Alternatively, you can link them both and have 
both as “Masters.”

• If at any point the species field is too full (for example, when Kaleidoscope Pro fills in a lot of information in parentheses 
after a space following the species ID label), you can move this information to the “Notes” field using COPY => PASTE.

• **IMPORTANT** It is critical that the auto ID labels be retained and remain in the “Species Field” so that these data 
are retained through to the final spreadsheet.
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• “Buffer” is located to the far right-hand side of the species list. Use this if you want to have a “push button” way of add-
ing a label to the “Species Field” that is, more than eight characters long. You can only have two buffer labels (top two) 
that will add to a “Species Field” when clicked. Enter a label into the “Buffer” by first typing into the “Species Field” 
exactly what you want to save into the “Buffer”. Then click the “Save” button next to the “Buf1+” or “Buf2+” buttons. 
The “Buf” button is now lit and ready to use as another “Species Label”.

Using Filters in AnaLookW

1. Obtain AnaLookW filters. It is recommended that only Strict or “Diagnostic” type species filters be used. (If you are sim-
ply scrubbing out noise files from bat files, then an “AllBats” filter can be used.)

• Filter files (.abf files) can be obtained from trusted sources, or you can create a filter by filling in appropriate param-
eters.

• If you are not an advanced user, then these parameters should be obtained from a trusted source. Parameters can be 
inserted into the filters using FILTER => NEW FILTER => SAVE FILTER.

2. Apply filter(s). 
Choose one of the following options.

Option 1: You can apply a filter to any given folder of bat files (FILTER => LOAD FILTER, then FILE => MARKING => 
MARK IF PASS FILTER, then view marked files and (or) perform EDIT => GLOBAL HEADER CHANGE).

Option 2: Use a Scan to apply one or more filters at one time. Be sure to only select the output option “ANL”. This produces a 
“scan file” (.anl file format). Recall that using a “Scan” instead of applying a filter on a per folder basis has the advantage 
of seeing all files of a dataset from all subfolders at once in one “virtual folder” (.anl file). This allows actions to be com-
pleted on the dataset all at once, despite the fact they are in separate subfolders (for example, nightly folders). “Scan” files 
(.abs) are required if you are going to scan with more than one filter at a time.

3. Once a filter/scan has been applied, you should put a species label into the Species field of the header so that you know this 
file has passed a species-level filter. You will use species labels such as fLABO. This means you used a filter to identify 
a file that is likely a LABO bat pass. The use of the lower case “f” is a good idea, as AnaLookW has the ability to ignore 
lower case initial letters in downstream analyses. The use of a prefix such as “f” or “m” is critical for NABat downstream 
analyses as it conveys how the species label was determined (f = by filter; m = by manual vetting).

• If you applied a single filter to a folder (MARK IF PASS FILTER) then simply use GLOBAL HEADER CHANGE to 
apply a label (for example, fLABO for files that passed the LABO filter).

• If you applied a scan of a single or multiple filters, use the .anl file to view each field (generally each field is the name 
of the filter). For each field, MARK ALL, then GLOBAL HEADER CHANGE to insert a species label into the Header 
(for example, fLABO). Do for each field.

Conclusion: All files that passed a strict or diagnostic filter have now had a species label inserted into its metadata. You are 
ready to manually vet, see chapter 5, Step 4. Manual Vetting.
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Appendix C. Bat Auto ID Species Confusion Matrix
This appendix provides a “Bat Auto ID Species Confusion Matrix” as a quick look-up guide indicating which species are 

commonly confused by auto ID software. In the matrix, red cells indicate species not currently included in classifiers used for 
automated species identification. Grey cells (along diagonal) are not applicable to the matrix. 

Click on the link to open the Excel file: ofr2018-1068_appendixC_BatAutoID_SpeciesConfusionMatrix.xlsx

https://doi.org/10.3133/ofr20181068
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ANPA X X X X X X X X X
ARJA X X X X
CHME X X X
CORA X X X X
COTO X X X X X X X X X X
EPFU X X X X X X X X X X X
EUMA X X X
EUFL X X
EUPE X ? ? ? X Need more information.
EUUN Not currently included in classifiers.
IDPH X X Included in Sonobat classifier for Arizona (AZ).
LANO X X X X X X X X
LABL X X X X X X X X
LABO X X X X X X X X X X X X X X X
LACI X X X X X X X X X Not currently included in classifiers.
LAEG Included in SonoBAt 4 classifier for southeaset Arizona 

(SE-AZ); but as a species (spp.) pair (that is,. LEP 
spp.). Leptonycteris spp. are likely acoustically indis-
tinguishable from each other; must rely upon ranges 
to discriminate

LAIN X X X X X
LASE X X X X X X X X
LAXA X X X X X X X X X
LENI X Included in SonoBAt 4 classifier for SE-AZ; but as a spp. 

pair (that is, LEP spp.). Leptonycteris spp. are likely 
acoustically indistinguishable from each other; must 
rely upon ranges to discriminate

LEYE X
MACA
MOMO Not currently included in classifiers.
MOME Not currently included in classifiers.
MYAR X X X Not currently included in classifiers.
MYAU X X X X X X Included in Sonobat classifier for AZ. More information 

needed.MYCA X X X X X X X X
MYCI X X X X X X X X X X X

*Same species as MYEV (Lausen, C.L., Burles, D., Ble-
jwas, K., Nagorsen, D., Govindarajulu, P. and Friis, 
L. 2017. Long-eared bat taxonomy: Nuclear genetic 
evidence eliminates the species status of Keen’s 
Myotis (Myotis keenii). North American Symposium 
on Bat Research, Oct. 2017. )

MYEV X X X X X X X X X X
MYGR X X X X
MYKE*
MYLE X X X X X
MYLU X X X X X X X X X X X X X X X X X X
MYOC Not currently included in classifiers.
MYSE X X X X X X X X X X X
MYSO X X X X X X X
MYTH X X X X X X X
MYVE X X X Included in Sonobat classifier for AZ.
MYVO X X X X X X X X X X

Included in the SonoBat 4 classifier for SE-AZ; but as 
a species pair (that is, NYC spp.). Nyctinomops spp. 
are likely acoustically indistinguishable from each 
other; must rely upon ranges to discriminate

MYYU X X X X X X X
NYHU X X X X X X X X
NYFE X X X X
NYMA X X X X X

Included in the SonoBat 4 classifier for SE-AZ; but as 
a species pair (that is, NYC spp.). Nyctinomops spp. 
are likely acoustically indistinguishable from each 
other; must rely upon ranges to discriminate

PAHE X X X X X X X X
PESU X X X X X
TABR X X X X X X X X
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Center Director, USGS Fort Collins Science Center
2150 Centre Ave., Bldg. C
Fort Collins, CO 80526-8118
(970) 226-9398
 
Or visit the Fort Collins Science Center website at
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